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Abstract : Three-wheeled vehicles  is one of the vehicles with the latest innovations and technologies that 

are currently evolving. Three-wheeled vehicle is designed based on the concept of three-wheeled vehicle 

for stability, safety and driving ability with a maximum total width of about 1300 mm. The design of this 

prototype is incorporates the concept of vehicles with ATVs buge, where the front suspension is designed 

using two shock absorber with a swinging arm on the left and right that can move dynamically as ATVs. 

Analysis in order buge prototype vehicle is done by using finite element software. The goal of this study is 

to determine the deformation that occurs as well as critical areas and secure areas in order. The  load  used 

in this simulation is 1000 N that is a combination of passenger weight (800 N) and heavy machinery (200 

N). The material used is steel ST 42 with a modulus of elasticity of 200,000 MPa, Poisson ratio of 0,27, and 

the yield strength of 415 MPa. After the analysis is done, the maximum von Mises stress is obtained (SMX) 

is 78,518 MPa at L46 rod (swing arm front), the minimum von Mises stress (SMN) is 0,079775 MPa at the 

rod L22 (cradle seat), the deflection occurs (DMX) is 3,745 mm , and obtained safety factor is for 5,285. 

 

Keywords: Frame buge prototype vehicles, stress, finite element method 

 

 

Abstrak : Kendaraan roda tiga (Three Wheelers) adalah salah satu kendaraan dengan inovasi dan teknologi 

terbaru yang saat ini berkembang. Kendaraan roda tiga ini didesain berdasarkan konsep kendaraan roda tiga 

untuk stabilitas, keselamatan dan kemampuan pengendaraan maksimum dengan lebar total sekitar 1300 

mm. Rancangan prototype ini memadukan konsep kendaraan buge dengan ATV,dimana suspensi bagian 

depan dirancang mengunakan dua shock breaker dengan lengan ayun di kiri dan kanan yang mampu 

bergerak dinamis layaknya ATV. Analsis pada rangka prototype kendaraan buge ini dilakukan dengan 

menggunakan finite elemen software. Tujuannya untuk mengetahui deformasi yang terjadi serta daerah 

kritis dan daerah aman pada rangka. Berat beban yang digunakan sebesar 1000 N yang merupakan berat 

penumpang 800 N dan berat mesin 200 N. Bahan yang digunakan adalah baja ST 42 dengan modulus 

elastisitas 200000 MPa, Poisson ratio 0.27, dan yield strength 415 MPa. Setelah proses analisis dilakukan, 

diperoleh tegangan von Mises maksimum (SMX) sebesar 78.518 MPa pada batang L46 (lengan ayun 

depan), Tegangan terendah (SMN) sebesar 0.079775 Mpa pada batang L22 (dudukan jok), defleksi yang 

terjadi (DMX) sebesar 3.745 mm, dan diperoleh faktor keamanan (safety factor) sebesar 5.285.  

 

Kata kunci : Rangka prototype kendaraan buge, Tegangan, metode elemen hingga 

 

PENDAHULUAN 

Kendaraan roda tiga (Three 

Wheelers) adalah salah satu kendaraan 

dengan inovasi dan teknologi terbaru 

yang saat ini berkembang. Hal tersebut 

dapat dilihat dengan munculnya berbagai 

produk baru dengan konsep roda tiga 

seperti piaggio MP 3, Buge, dan Peugeot 

Hybrid3 Evolution. Buge sendiri sudah 

diproduksi di Amerika oleh Mark 

Murphi dari Blue Sky Design 2008. 

Kendaraan roda tiga ini didesain 

berdasarkan konsep kendaraan roda tiga 

untuk stabilitas, keselamatan dan 

kemampuan pengendaraan maksimum 

dengan lebar total sekitar 1300 mm yang 
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membuat kendaraan ini nyaman 

dikendarai. Kendaraan ini juga 

menjanjikan pangsa pasar pada industri 

pariwisata sebagai kendaraan wisata. 

Dalam pembuatan prototype kendaraan 

buge ini penulis memadukan konsep 

kendaran buge dengan ATV. 

Desain rangka prototype kendaraan 

buge ini dibuat berdasar kendaraan yang 

sudah ada dengan menambahkan inovasi 

dan melakukan modifikasi sehingga 

memberikan kelebihan dibanding 

kendaraan yang sudah ada. Rangka dari 

kendaraan ini didesain seperti pada 

Gambar 1 

 

 

 

 

 

 

 

 

Gambar 1. Rangka kendaraan buge. 

 

Rancangan prototype ini 

memadukan konsep kendaraan buge 

dengan ATV, dimana suspensi bagian 

depan dirancang mengunakan dua shock 

breaker dengan lengan ayun di kiri dan 

kanan yang mampu bergerak dinamis 

layaknya ATV. Rangka tengah didesain 

untuk menopang 1 orang pengendara 

dengan memperhatikan kenyamanan 

berkendara seperti mobil. Bagian rangka 

belakang mengaplikasi suspensi tunggal 

(monoshock) yang di pasang di bagian 

tengah. Faktor keselamatannya didukung 

dengan sistem pengereman 

menggunakan rem tromol (drum brake) 

pada ketiga rodanya. Peforma kendaraan 

ini sangat baik karena didukung dengan 

mesin 100 cc dari mesin sepeda motor 4 

tak SOHC dengan pemindah daya 

menggunakan rantai sepeda motor 

sehingga kendaraan dapat melaju tidak 

terlalu cepat tapi punya power mesin 

yang besar dan stabil. Kendaraan ini 

juga dapat dikendarai baik siang maupun 

malam hari karena dilengkapi dengan 

lampu kepala, stop light, sein, dan 

klakson. 

Beberapa pertimbangan diatas dapat 

diambil beberapa rumusan masalah 

sebagai berikut bagaimana menganalisis 

rangka dengan metode elemen hingga 

menggunakan metode elemen hingga. 

 

Tujuan Penelitian 

Merancang, menganalisis, dan 

membuat rangka prototype kendaraan 

buge dengan kapasitas satu penumpang 

yang  berfumgsi sebagai penopang 

55 Analisa Tegangan pada Rangka Prototype Kendaraan Buge Menggunakan Elemen Hingga - -

Rochmad Winarso, Nano Yulianto 



56 
TEKNIK - UNISFAT,  Vol. 6, No. 2,  Maret  2011  Hal 54 - 63 

 
JURNAL 56 

mesin, body, suspensi, sistem kemudi 

dan lain-lain. 

 

TINJAUAN PUSTAKA 

a. Pengerian Chasis 

Chasis merupakan komponen utama 

kendaraan, yang mana berfungsi untuk 

mendukung keberadaan mesin, 

transmisi, pegas dan pada chasis itu 

pulalah di pasangkan body kendaraan. 

Astra motor (1995) mendefinisikan 

system chasis meliputi suspensi yang 

menopang poros, kemudi untuk 

mengatur arah kendaraan, roda, ban dan 

rem untuk menghentikan jalannya 

kendaraan. Fungsi utama dari frame 

chasis adalah: 

1. Untuk mendukung gaya berat dari 

kendaraan yang berpenumpang 

2. Untuk menahan torsi dari mesin, 

kopling sentrifugal, aksi                        

percepatan danperlambatan, dan 

juga untuk menahan gaya torsi     

yang diakibatkan dari bentuk 

permukaan jalan. 

3. Untuk menahan beban kejut yang 

diakibatkan benturan dengan benda 

lain. 

4. Sebagai landasan untuk meletakan 

bodi kendaraan, mesin serta kopling 

sentrifugal, tangki bahan bakar, 

tempat duduk penumpang. 

5. Untuk menahan getaran dari mesin 

dan getaran yang ditimbulkan 

karena efek bentuk permukaan jalan 

Rangka mobil yang banyak di 

gunakan adalah rangka jenis 

konvensional. Rangka ini harus dibuat 

kuat untuk menehan beban-beban yang 

ditempatkan padanya, ia harus tahan 

terhadap bengkok atau patah waktu 

kendaraan berjalan dan mengalami 

kejutan dengan gaya kejut tertentu. 

Rangka konvensional jenis 

perimeter adalah salah satu jenis rangka 

yang sering digunakan pada kendaraan, 

dimana model atau bentuk dan  bangun 

rangka ini berbentuk persegi dan 

biasanya digunakan pada kendaraan-

kendaraan setengah berat. 

Rangka kendaraan mini car 

biasanya mengaplikasikan jenis-jenis 

rangka yang sudah ada. Seperti gokart, 

gokart sport menggunakan rangka jenis 

frame chasis yang biasanya berbahan 

pipa, digunakan untuk menahan sistem 

rigid dan biasanya dibutuhkan  untuk 

menunjang kegunaannya yang 

membutuhkan akselarasi dan kecepatan 

tinggi. Sedangkan gokart off road, untuk 

menunjang kegunaannya di jalan 
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h 

b 

bergelombang membutuhkan sistem 

suspensi yang baik dan rangka yang kuat 

untuk melindungi pengendaranya, maka 

gokart off road mengaplikasikan 

perpaduan rangka integral/monoshock 

dengan rangka konvensional jenis 

perimeter yang sudah dimodifikasi 

sedemikian rupa. Mini car yang lain 

seperti mobil buge dan mobil-mobil mini 

dengan satu sampai dua penumpang juga 

mengaplikasikan perpaduan antara 

rangka jenis frame chasis dengan rangka 

konvensional jenis perimeter yang sudah 

dimodifikasi. 

 

b. Momen inersia 

Mencari momen inersia pada 

penampang pipa profil kotak dan pipa 

bundar 

 

 

 

 

 

 

 

 

 

 

Tebal pipa = 

 

Dimana  = Momen inersia 

=  Lebar penampang pipa  

    (mm) 

= Tinggi penampang pipa    

    (mm) 

   = Tebal penampang 1  

          (mm) 

   = Tebal penampang 2  

                            (mm) 

 = Jari jari lingkaran besar  

           (mm) 

= Jari jari lingkaran kecil  

   (mm) 

Faktor keselamatan (safety factor) 

 

 

 

 

 

 

PROSEDUR PENELITIAN 

Finite elemen softwere adalah suatu 

software yang berbasiskan metode 

elemen hingga (MEH). MEH adalah 

suatu metode analisa dengan cara 

membagi sistem yang dianalisa menjadi 

elemen-elemen yang lebih kecil dengan 

bentuk yang sederhana, elemen-elemen 

tersebut terdiri dari beberapa nodal. 

Sehingga nodal tersebut merupakan 

representasi dari jenis pembebanan dan 

analisa yang diberikan pada sistem 

tersebut. 

Prosedur Finite Element Analysis 

secara garis besar terdiri dari: 

 Preprocessor, meliputi pembuatan 

Area/Volume, penentuan jenis 

h 

b 

(Brown,Jr, 

2005) 
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elemen yang dipakai, spesifikasi 

material, meshing, dll. 

 Solution, meliputi penentuan kondisi 

batas, jenis analisa, pemecahan 

masalah, dll. 

 General Postproc, merupakan 

fasilitas untuk melihat hasil dari 

simulasi yang telah dilakukan. 

Dalam analysis rangka prototype 

kendaraan buge digunakan distribusi 

tegangan von Misses. von Misses stress 

dalam bidang material dan engineering 

sama dengan tensile stress, yang 

merupakan besaran scalar yang dapat 

dihitung dari tensor stress (Wikipedia). 

Dalam software paket von Misses stress 

merupakan tegangan efektif dimana 

material dianggap sebagai ductile/liat. 

Berikut adalah flow chart proses 

perancangan, analisis, pembuatan rangka 

prototype kendaraan buge (Gambar 2). 

 

 

 

 

 

 

 

 

Gambar 2. Flow chart proses 

perancangan dan pembuatan 

rangka. 

Desain rangka/chasis kendaraan 

buge yang dianalisa adalah sebagai 

berikut (Gambar 3). 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3. Desain rangka buge. 

 

Pada simulasi pembebanan rangka  

kendaraan ini di desain dengan satu 

penumpang jadi beban yang ditanggung 

rangka adalah berat penumpang dan 

berat mesin. Berat penumpang di 

asumsikan 80kg, jadi 80 kg x 9.81 = 

784.8 N   dibulatkan 800 N dan Berat 

mesinnya adalah 22kg jadi 22 kg x 9.81 

= 215.82 N dibulatkan 200 N. 

Bahan yang digunakan pada 

pembuatan rangka kendaraan buge ini 

adalah baja ST 42 dengan modulus 

elastisitas 200.000 MPa, Poisson ratio 

0.27, dan yield strength 415 MPa. 

Berikut hasil spesifikasi bahan yang 

digunakan dalam simulasi setelah 

dilakukan perhitungan (Tabel 1). 
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Tabel 1 Spesifikasi bahan setelah 

disamakan berdasar momen inersi 

 

Langkah simulasi pembebanan 

dengan menggunakan software Ansys 

versi 11.0 dapat dilihat pada Gambar 4. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 Gambar 4. Diagram alir simulasi. 

 

c. Proses permodelan 

1. Menentukan titik-titik (keypoints) 

pada sistem koordinat dengan langkah 

sebagai berikut: Pilih Main Menu > 

Preprocessor > Modeling > Create > 

Keypoints > In Active CS kemudian 

akan muncul menu Create Keypoints 

in Active Coordinate, masukkan ke 38 

titik koordinat yang telah ditentukan 

> OK. 

Membuat garis (lines) dengan 

langkah sebagai berikut: Pilih Main 

menu > Preprocessor > Modeling > 

Create > Lines > Lines > Straight Line. 

Hubungkan semua titik koordinat hingga 

terbentuk garis seperti terlihat pada 

Gambar 5. 

 

 

 

 

 

 

 

 

 

 

 

Gambar 5. line dari titik koordinat. 

2. Penentuan element type dengan 

langkah sebagai berikut: Pilih Main 

menu > Preprocessor > Elemen Type 

> Add/Edit/Delete > Add.Masukkan 

element type yang dipakai, pipe Elast 

straight16. 

No Bagian Jenis bahan Ukuran 

(mm) 

Material 

1 Rangka 

utama 

Besi pipa 

profil (o) 

ᴓ 40 tebal 

3.3 

Baja ST 42 

2 Lengan 

ayun depan 

Besi pipa 

profil (o) 

ᴓ 20 tebal 3 Baja ST 42 

3 Lengan 

ayun 

belakang 

Besi pipa 

profil (o) 

ᴓ 40 tebal 

3.2 

Baja ST 42 

4 Dudukan 

mesin 

Besi pipa 

profil (o) 

ᴓ 47.5 tebal 

3.14 

Baja ST 42 

5 Dudukan 

jok 

Besi pipa 

profil (o) 

ᴓ 27.5 tebal 

2.75 

Baja ST 42 
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3. Penentuan ukuran material dengan 

langkah sebagai berikut: Pilih Main 

menu > Preprocessor > Real 

Constant > Add/Edit/Delete > Add. 

Dari menu Real Constant Set 

Number, masukkan nomor elemen, 

diameter dan ketebalan kelima bahan 

klik OK. 

4. Penentuan sifat material (material 

property) dengan lengkah sebagai 

berikut:Pilih Main menu > 

Preprocessor > Material Props > 

Material Models.  kemudian dari 

menu Define Material Model 

Behaviour pilih Structural > Linear > 

Elastic > Isortropic. Pada menu 

Linear Isotropic Properties for 

Material Number masukkan 

spesifikasi bahan dengan nilai 

modulus elastisitas pada EX = 200000 

GPa dan Possion’s ratio pada PRXY 

= 0.27 

5. Proses Meshing dengan langkah 

sebagai berikut: Proses meshing 

merupakan proses membagi 

komponen dalam elemen-elemen 

kecil. Tentukan letak material pada 

garis Sesuai Real constant set number 

yang telah ditentukan. Tentukan 

panjang alur distribusi tegangan 

dengan memilih Main menu > 

Preprocessor > Meshing > Size cntrls 

> Manual Size > Lines > All lines, 

kemudian masukkan nilai 5 menu 

Element Sizes On All Selected Lines > 

OK. Pilih Main menu > Preprocessor 

> Meshing > Mesh > Lines, 

kemudian akan muncul menu Mesh 

lines lalu klik Pick All. Maka akan 

muncul seperti pada Gambar 6. 

 

 

 

 

 

 

 

 

 
Gambar 6. hasil proses meshing. 

 

d. Proses solusi (solution) 

1. Analysis Type dengan langkah 

sebagai berikut: Pilih Main menu > 

Solution > Analysis Type > New 

Analysis > Static > OK. 

2. Penentuan kondisi batas dengan 

langkah sebagai berikut: Pilih Main 

menu > Solution > Define Loads > 

Apply > Structural > Displacement > 

On Keypoints. Pilih titik yang akan 

digunakan untuk kondisi batas lalu 

klik OK. Pilih UY dan UZ pada DOFs 

to be constrained kemudian klik OK. 

3. Pembebanan dengan langkah sebagai 

berikut: Pilih Main menu > Solution 
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> Define Loads > Apply > Structural 

> Force/Moment > On Keypoints. 

Pilih letak titik pembebanan, titik 1 

pada dudukan jok dan titik 2 pada 

dudukan mesin (engine base) 

kemudian klik OK. Pilih FY pada 

menu Apply F/M on KPs dan 

masukkan nilai gaya masing masing -

800 N pada titik 1 dan -200 N pada 

titik kemudian klik OK seperti pada 

Gambar 7. 

 

 

 

 

 

 

 

 

 

Gambar 7. Titik yang dikenai 

pembebanan. 

 

4. Pemecahan masalah (solving) dengan 

langkah sebagai berikut: pilih Main 

menu > Solution > Solve > Current 

LS > OK. Maka akan muncul menu 

Note dan Status Command, jika 

terdapat kalimat Solution is done! 

Maka proses solution dinyatakan 

berhasil, dan jika Error berarti gagal. 

 

e. Simulasi proses post-processing 

1. Plot hasil deformasi dengan langkah 

sebagai berikut: Pilih Main menu > 

General Postproc  > Plot results > 

Deformed Shape > Def + 

Undeformed > OK, maka akan 

terlihat bentuk hasil deformasi akibat 

pembebanan seperti pada Gambar 8. 

 

 

 

 

 

 

 

 

 

 

Gambar 8. Hasil simulasi. 

 

2. Plot Distribusi tegangan von Misses 

dengan proses sebagai berikut: Pilih 

Main menu > General Postproc > 

Element Table > Define Table > add, 

dari menu Define Additional Element 

Table items pilih Dof Solution > UY > 

Apply. Pilihlah Stress > von Misses 

stress, kemudian klik OK. 

3. Menentukan Plot Element Table 

dengan langkah sebagai berikut: pilih 

Main menu > General Postproc > 

Element Table > Plot Elem Table, 

kemudian dari menu Contour Plot of 

Element table Data Pilih SEQW 

kemudian klik OK, Maka akan 

terlihat distribusi tegangan von Misses 

seperti pada Gambar 9. 

 

Titik 1 

Titik 2 
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Gambar 9. Plot distribusi tegangan von 

Misses 

 

HASIL SIMULASI 

Dari simulasi pembebanan rangka 

kendaraan buge dapat diperoleh hasil 

sebagai berikut: 

 Defleksi yang terjadi (DMX) =   

3.745 mm 

 Tegangan terendah (SMN) = 

0.079775 MPa pada batang L22 dekat 

titik 22 

 Tegangan terbesar (SMX) = 78.518 

MPa pada batang L46 dekat titik 38 

 

Menghitung faktor keamanan (Safety 

Factor) 

Diketahui: Ys =  415  MPa 

Ds = 78.518 MPa 

 

 

 

 

 

 

 

Dengan nilai faktor keamanan 5.285 

Mpa maka rangka prototype kendaraan 

buge ini aman digunakan. 

 

KESIMPULAN 

Dari penelitian ini telah berhasil 

dirancang dan dibuat rangka prototype 

kendaraan buge dengan hasil kesimpulan 

sebagai berikut: 

 Rangka prototype kendaraan buge ini 

mempunyai dimensi panjang x lebar 

dengan ukuran 1250 mm x 800 mm. 

 Bahan yang digunakan adalah besi 

pipa profil kotak (□) dengan 

spesifikasi baja ST 42 yang 

mempunyai modulus elstisitas 

200000 Mpa, poisson ratio 0.27, dan 

yield strength 415 Mpa. 

 Dari hasil analysis yang dilakukan 

pada rangka prototype kendaraan 

buge dapat diperoleh beberapa hal 

sebagai berikut: defleksi yang terjadi 

(DMX) = 3.745 mm, tegangan 

terendah yang terjadi (SMN) = 

0.079775 MPa pada batang L22 dekat 

titik 22, titik ini merupakan titik 

paling aman dari rangka buge, 

tegangan terbesar (SMX) = 78.518 

MPa pada batang L46 dekat titik 38, 

titik ini merupakan titik paling rawan 

patah dari kendaraan buge. 
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 Berdasarkan hasil simulasi 

pembebanan diatas dapat diketahui 

faktor keamanan (safety factor) 

sebesar 5.285 Mpa, maka dapat 

disimpulkan bahwa rangka prototype 

kendaraan buge yang akan dibuat 

aman digunakan. 

Saran untuk perancangan rangka 

hendaknya lebar kendaraan jangan 

terlalu pendek agar kendaran lebih stabil 

pada saat belok.  
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